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Unidad 1: Métodos experimentales
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Pauta de trabajo

Unidad 1: Métodos experimentales

Nombre RUT Firma Seccién | Grupo

A. Objetivos

= Aprender a utilizar el sensor de fuerza

= Aprender a usar el programa NIMAX para verificar que el sensor de fuerza esta funcionando
correctamente

= Aprender a utilizar el programa SignalExpress para la adquisicién de datos, en particular con el
sensor de fuerza.

= Realizar una serie de mediciones de la tensién de corte de un hilo de coser.

= Analizar los resultados experimentales usando conceptos basicos de estadistica.

B. Materiales

= Sensor de fuerza
= Dispositivo experimental (polea, poste e hilo de coser)

= Programas Matlab, NIMAX y SignalExpress
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C. Experiencias

Experiencia 1.- Verificacién del sensor de fuerza y de la tarjeta de adquisicién con
el programa NIMAX:

Comenzaremos por verificar la conexiéon del sensor de fuerza a la tarjeta de adquisicion. El
sensor tiene tres conexiones: sefial, tierra y +5 V, identificados como Entrada, GND y +5
V respectivamente. Conecte entonces estos cables en los siguientes canales de la tarjeta de
adquisicién:

= Cable Rojo — canal AlO

= Cable Negro — canal GND

= Cable Naranjo — canal AOO
Ahora verifique que el sensor de fuerza que estd conectado con el canal de entrada analogo

namero 0 (AlQ) esta trabajando adecuadamente. Para ello lance la aplicacién NIMAX (programa
de medida y automatizacién), cuyo icono se encuentra en el escritorio de su computador.

Al abrirse la Barra del Ment Principal, seleccione Configuration — Devices and Interfaces —
NI-DAQmx — NI USB-6008: Dev n, siendo n un niimero, normalmente 1. Seleccione Self-Test,
la respuesta debe ser The device has passed the self-test, de otra forma existe un problema de
conectividad. Pida ayuda al profesor o un profesor auxiliar en este caso.

Si el mensaje aparecido es el correcto, presione OK.

La tarjeta requiere +5 V de alimentacién para ello, abra Test Panel y haga clic en Analog
Output. Aseglrese que el sensor estd siendo alimentado con 5 V. Para ello ingrese 5 en la
casilla Output Valuey presione Update. Atencién de no cambiar los parametros por defecto que
se encuentran en la parte superior de esta ventana.

Ahora pruebe que el sensor de fuerza mide correctamente. Seleccione Analog Input. Use los
siguientes parametros de adquisicion:
= Mode: Continuous
Max Input Limit: +10V
Min Input Limit: -10 V
Input Configuration: RSE
Channel Name: AlO
Rate (Hz): 1000
Samples to read: 1000

Lance la medida presionando sobre el botén Start. Como el modo seleccionado de adquisicion
es continuo, deberia ver una medida constante de aproximadamente 2,5 V, lo que implica que
la fuerza sobre el sensor es nula. Puede presionar con su dedo sobre el gancho del sensor y vera
como la sefial varia en tiempo real en su pantalla.
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Complete la siguiente tabla con los valores aproximados de voltaje que entrega el sensor de
fuerza en dos posiciones, con el gancho apuntando hacia arriba y hacia abajo:

Posicién Voltaje
Arriba
Abajo

Experiencia 2.- Segunda verificacién con el programa SignalExpress:

Ahora verificaremos que el programa SignalExpress funciona adecuadamente. La diferencia es
que con esta aplicacion se pueden grabar los datos en su PC en formato de una archivo de texto,
ademas de poder realizar algunos analisis basicos. Cierre el programa anterior. Lance la aplicacién
con el archivo llamado TensiénDeCorte.seproj que se encuentra en U-Cursos. Identifique tres
botones a la izquierda que se llaman respectivamente Analog Output, Analog Input y Save to
ASCII. Estas son tareas ya preasignadas. Usted puede cambiar los pardmetros pero antes de
hacerlo anote los valores preasignados pues en principio estan definidos para un buen uso para
la experiencia 3.

Con Analog Output y Analog Input se configuran la salida AOO y entrada AI0 de una manera
muy similar a lo que se hizo en la experiencia 2.

Con la botonera Save to ASCII puede elegir un nombre de archivo como también un directorio
donde guardarlo. Tenga cuidado de mantener el formato de archivo con ASCII (formato texto),
pues asi podra leer facilmemte los datos con Matlab. Verifique que su configuracién de Windows
graba los nameros con punto decimal y no coma.

Ahora pruebe la medida de tensién de corte de un hilo, lanzando la medicién con el boton Run
Once. Esto lanza las tres tareas mencionadas en forma consecutiva.

El hilo debe atarse un extremo al sensor de fuerza y el otro extremo pasarlo por la polea y
anudarlo al dedo de la persona que tirara firme, pero suavemente incrementando la magnitud
de la tension aplicada. Se puede visualizar la adquisicion seleccionando la lenglieta Data View
y simplemente arrastrando el cursor desde Analog Input hacia esta ventana. Puede también
leer estos datos desde Matlab usando la funcién load(’archivo.txt’) donde archivo es el
nombre del archivo donde se guardaron los datos.

Con esta prueba determine el rango en el cual usara el sensor, 210 N 6 £50 N. Explique la
eleccion del rango:

Experiencia 3.- Medicién de la tensién de corte de un hilo:

Usando hilos de un mismo grosor y largo, repita la medicién de tensién de corte un minimo de
15 veces y anote los valores obtenidos en la tabla adjunta (ver anexo). Use el mismo largo que
los otros grupos de su mesa.
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Sistemas Newtonianos

Con los datos obtenidos por su grupo realice un histograma que muestre la distribucién de

ocurrencia de la tensidon de corte del hilo.

Con los datos obtenidos por su mesa realice un histograma que muestre la distribucién de

ocurrencia de la tensién de corte del hilo.

Imprima y adjunte los graficos en el informe.

Determine el valor medio y la desviacién estandar de la tensién de corte. Llene la siguiente tabla:

Grupo

Mesa

<Tcorte>

g (Tcorte )

<Tcorte >

g (Tcorte)

D. Conclusiones

Presente de manera concisa las conclusiones objetivas de la sesién en general, no debe resumir
otra vez todos los resultados, sino aquellos mas importantes. Enumere las dos fuentes de error mas
importantes en su proceso de medicion.
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Anexo: Tension en el sensor

Para encontrar la tensién T a partir del voltaje promedio medido V' se utilizan las constantes A
y B de cada sensor de fuerzas:
T = AV + B [N],

donde las constantes A y B las suponemos conocidas. Si el sensor de fuerzas se utiliza en el rango
+10 N, las constantes que deben usar son A = —4,9 N/Vy B = 12,25 N. Si el sensor de fuerzas se
usa en el rango £50 N, las constantes son A = —24,5 N/Vy B = 61,25 N.
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Pauta de trabajo
Unidades 2 y 3: Métodos Numeéricos y Sistemas Extendidos

Nombre RUT Firma Seccién | Grupo

A. Objetivos

= Conocer las capacidades de los métodos numéricos para la solucién y analisis de los sistemas
newtonianos.

= Aprender a usar el método de Verlet para integrar las ecuaciones de Newton.
= Aprender a calcular los centros de masa de objetos de forma compleja.

= Aprender a usar Matlab con los fines anteriormente descritos.
B. Materiales:

= Matlab
C. Experiencias

Experiencia 1.- La ecuacién de movimiento de un péndulo simple de
longitud L es:

&= 2 sen(9),

donde ¢ es el angulo que describe respecto a la vertical.

Considere que el péndulo se suelta desde el reposo en un angulo
inicial ¢, = 7/4. Use g = 9.8 m/s?, L = 0,5 m, At = 0,01 s,
0,05 sy 0,5 s. Resuelva la ecuacién hasta t = 10 s. Se pide grafi-
car la solucién ¢(t) para los diferentes valores de At y estudiar el
acuerdo de la solucién con el movimiento esperado de un péndulo.
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Imprima y adjunte los graficos en el informe.

Experiencia 2.- Usando el programa anterior programe el movimiento del péndulo para los angulos
iniciales ¢, = m/10,m/4 y 97/10, usando g = 9,8 m/s?, L = 0,5 my At = 0,01 s. A
continuacién use uno de estos métodos:

= Escriba un programa que detecte el primer cruce con la vertical (esto es, cuando ¢ = 0)
y con este programa calcule el periodo del péndulo (T") para los tres angulos iniciales ya
mencionados.

= Alternativamente puede usar las herramientas graficas de Matlab para medir los periodos.
Dos opciones son: la herramienta de zoom o usando la instruccién ginput (para su uso
escriba el comando help ginput en Matlab). Con éstas podra determinar los tiempos
cuando la funcién pasa por cero o por un extremo.

Compare los periodos con el periodo del péndulo para pequefias amplitudes T}, = 274/ L/g.

Complete la siguiente tabla con sus datos. Indique las unidades de cada columna entre los
paréntesis.

angulo inicial ¢, | Periodo T | T/T,

C ) C ) [C )

Experiencia 3.- Considere un arco de circunferencia de radio R
y masa M distribuida uniformemente, centrada en el ori-
gen. Sus angulos extremos con respecto al eje = son 6; y
0; + «, respectivamente. Se busca determinar las coordena-
das (X¢m, Yem) del centro de masas del arco. Para ello, el
aro se modela como un conjunto discreto de N particulas
equiespaciadas, cada una de masa m = M/N. La posicién
de cada particula queda determinada por su posicién angu-

lar 6; multiplicada por el radio del arco. Puede construir en
MATLAB un arreglo con las posiciones angulares de las par-
ticulas: theta=(ti+d/2) :d: (ti+alpha-d/2), donde theta ' .
es el arreglo con las posiciones angulares, ti es el angulo ini- . L
cial 6;, alpha es el angulo de apertura del arco o y d es el ..
angulo entre las posiciones angulares de dos particulas con-

secutivas, que usted debe calcular.

Busque numéricamente las coordenadas (X, Yenn) del centro de masa de medio anillo, es
decir, con « = 7. Use M = 1.AA'y R = 1.BB, con AA y BB los altimos dos digitos del RUT
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de dos integrantes del grupo. Utilice N = 100 y los valores de 6; indicados en la tabla. Calcule
2. +Y2 /Ry explique qué representa este valor. Llene con sus datos la siguiente table,

indicando las unidades de cada columna.
M = R =

0; Xem Yem VX2 +Y5,/R
(rad) ( ) ( ) ( )

/4

/3

/2

3r/4

D. Conclusiones

Presente de manera concisa al menos dos conclusiones objetivas de las experiencias 1 y 2. Sefiale
cémo afecta el uso de diferentes valores de At en la precisién del resultado. No resuma nuevamente
todos los resultados obtenidos, sino aquellos mas importantes.

Por ejemplo, concluya cémo afecta el angulo inicial al periodo del péndulo.

Presente de manera concisa las conclusiones objetivas de la experiencia 3.
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Anexo 1: Recetario util Matlab

Opciones y comandos

= ;COomo crear un M-file? Seleccione File » New » M-File; escriba instrucciones.

= ;Como guardo lo escrito en un M-File? Seleccione File » Save file as...; asignele al archivo
extension .m

= ;Cémo grafico el arreglo y versus x con asteriscos verdes? Utilice plot(x,y,'g*'); utilice
b+ para cruces azules, o ko para circulos negros. Consulte un tutorial por mas opciones.

= ; Cémo graficar dos o mas curvas con una sola instruccién plot? Utilice plot(x1,y1,"*" x2,y2,’"-
' x3,y3,’k="), donde los simbolos entre comillas son opcionales.

= ;Cémo hacer un grafico de datos con barras de error? Utilice errorbar(x,y,err,”*"), donde
err es el arreglo de errores asociado a y, en las coordenadas x.

= ;Cémo incluir leyenda de los simbolos usados en un grafico? Utilice legend('/eyenda 1,

leyenda 2, ...") después de la altima instruccion plot. El orden de las leyendas sigue el orden
de las curvas desplegadas.

= ;Cémo cargar datos tabulados en un archivo? Si el archivo es ASCII, de nombre datos.dat,
use load datos.dat. Asi, x=datos(:,1) contiene la primera columna; y=datos(:,2) contiene
la segunda; etc.

= ;Cémo rotular un grafico? Después de la instruccion plot agregue
xlabel('x-texto")
ylabel('y-texto")
title("titulo")

Formas compactas de Matlab

= suma=sum(x): suma todos los elementos del arreglo x
= suma=sum(x.” 2): suma los cuadrados de elementos del arreglo x
= prom=mean(x): calcula el promedio del arreglo x

= z=x./y: define el arreglo z formado por el cociente de los elementos de x con los de y Ambos
arreglos deben tener el mismo namero de elementos.

= x=a:dx:b: define arreglo equiespaciado en dx, desde a, sin que exceda b.

Universidad de Chile oft fcfm
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Pauta de trabajo
Unidad 4A: Estatica

Nombre RUT Firma Seccién | Grupo

A. Objetivos

= Verificar las leyes de la estatica del sélido rigido.

= |dentificar errores aleatorios y sistematicos en la medicién y/o en el calculo de las condiciones
de equilibrio de un sélido.

B. Materiales

Barra soporte con regleta para aplicacién de torques y fuerzas.

Sensor de medicién de fuerzas.

Juego de masas de diferentes calibres.

Polea con hilo de nylon.

Regla y/o transportador.

C. Montaje

El montaje experimental se ilustra en la figura. El montaje permite colocar masas de diferentes
calibres, a diferentes distancias, para ejercer fuerzas y torques de distintas magnitudes. El hilo ejercera
la tensién necesaria para mantener la barra en equilibrio estatico. El sensor de fuerza permite medir
dicha tensién para cada configuracion de equilibrio.
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D. Experiencias

Experiencia 1. - Preliminares:

Montar el aparato y verificar el funcionamiento correcto del sensor de fuerzas (ver anexo 1).
Abrir Signal Express. Descargar el archivo Tension.seproj que esta en u-cursos. Medir la tensién
del hilo bajo una configuracién en que usted crea que la tensién sera alta para un conjunto de
medidas. jQué tensién obtuvieron? jEn qué rango varié dicha tensién al hacer experimentos
tales como mover la mesa, poner la barra fuera de la horizontal, rotar el sensor de fuerzas? j Con
qué precision creen que pueden medir fuerzas? jEn qué rango de validez utilizaran el sensor de
fuerzas?

Experiencia 2.- Masa de la barra
Dibuje la barra que usa en el experimento (fije el hilo de modo que la barra quede horizontal);
indique el sistema de coordenadas; indique todas las fuerzas actuando sobre la barra (diagra-
ma de cuerpo libre para cuerpo extendido). Escriba la ecuacién de torque a partir de la cual
encontrara la masa de la barra.

Universidad de Chile oft fcfm
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Llene la siguiente tabla, indicando las unidades de cada columna. Anote los valores de Ay B
que corresponden al rango de fuerzas que usa en el sensor (ver anexo 2). Estime el error en la
masa de la barra utilizando las férmulas de propagacion de errores.

Voltaje

Ovoltaje

A

B Tension

Otension

Masa-Barra

Error

Experiencia 3.- Tensién en funcién de la distancia de la carga al eje.
Indique las unidades bajo los nombres de las columnas, y luego llene la tabla con valores numéri-
cos variando la distancia de la carga al eje. Grafique la tensién en funcién de la posicién junto con
su barra de error utilizando el comando errorbar en Matlab (si distancia, Tension y sigma
son los arreglos de distancia, promedio y desviacion estandar de la tension respectivamente, este
comando se usa escribiendo errorbar(distancia,Tension,signma, ‘0’)).

distancia

( )

Voltaje

( )

( ) | (

Medida

Ovoltaje

Tension

)

Otension

( )

Calculada
Tensién-calc

( )

Imprima y adjunte el grafico a su informe.
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Experiencia 4.- Variacién de la tensién en funcién del angulo hilo—barra.
Indique las unidades bajo los nombres de las columnas, y luego llene la tabla con valores
numeéricos variando el angulo hilo—barra. Grafique la tensién en funcién del angulo, se les pide
graficar exclusivamente los puntos medidos con el comando errorbar de Matlab. En el mismo
grafico dibujar el resultado esperado teéricamente suponiendo que conocen todos los parametros
experimentales de manera exacta.

(

distancia

Hilo
angulo

) | ( )

Voltaje

( )

Medida

Ovoltaje

( ) | (

Tensién

Otension

( )

Calculada
Tensién-calc

( )

Imprima y adjunte el grafico a su informe.

E. Conclusiones

Presente de manera concisa las conclusiones objetivas de la sesién en general, no debe resumir

otra vez todos los resultados, sélo aquellos mas importantes.
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Anexo 1: Verificacién de los instrumentos

Al inicio de cada experimento es necesario verificar el funcionamiento correcto de los elementos a
usar. Es probable que el sensor de fuerzas y la tarjeta de adquisicion ya se encuentren instalados, sin
embargo antes de utilizarlos debe revisar que funcionen correctamente.

Recuerde que los cables del sensor deben estar conectados a la tarjeta de medicién en las siguientes
puertas:

= Cable negro (tierra) a GND
= Cable rojo (sefial) a AlO

= Cable naranjo (+5V) a AOO

Nota: Los simbolos GND, Al0 y AOO se refieren a ground (tierra), analog input 0 (entrada analé-
gica 0) y analog output 0 (salida analégica 0).

1. Usar la aplicacién NIMAX para verificar que la tarjeta y el sensor funcionan correctamente.
En el mena principal seleccionar Configuration — Devices and Interfaces — NI-DAQmx —
NI USB-6008: Dev n, donde n es normalmente 1. Probar Self-Test. Se debe abrir un cuadro
indicando que el dispositivo ha pasado el Self-Test.

Luego Abrir Test Panel e ingrese 5 V bajo Analog Output y presione Update. Finalmente
seleccionar Analog Input y verificar que el sensor da una medida cercana a 2,5 V sin fuerza
aplicada. Cerrar la aplicacién Measurement and Automation.

Anexo 2: Tension en el sensor

Para encontrar la tensién T a partir del voltaje promedio medido V' se utilizan las constantes A
y B de cada sensor de fuerzas:

T = AV + B [N],

donde las constantes A y B las suponemos conocidas. Si el sensor de fuerzas se utiliza en el rango
+10 N, las constantes que deben usar son A = —4,9 N/V y B = 12,25 N. Si el sensor de fuerzas se
usa en el rango £50 N, las constantes son A = —24,5 N/Vy B = 61,25 N.

Universidad de Chile oft fcfm



Unidad 4B: Sélidos rigidos—Energia
cinética de rotacion

19



s

Fisica

FACULTAD DE GIENGIAS
FISICAS ¥ MATEMATICAS

UNIVERSIDAD DE CHILE

FI11002 - SISTEMAS NEWTONIANOS

Departamento de Fisica

Facultad de Ciencias Fisicas y Matematicas

Universidad de Chile

Pauta de trabajo

Unidad 4B: Energia de Rotacién

Nombre

RUT

Firma

Seccién | Grupo

A. Objetivos

= Conocer el efecto de la geometria sobre el momento de inercia de un cuerpo.

= Verificar el principio de conservacién de la energia mecanica.

= |dentificar errores aleatorios y sistematicos en la medicién y/o en el calculo de la energia cinética

de rotacién.

B. Materiales

= Camara web.
= Regla milimetrada.

= Balanza digital.

C. Montaje

El montaje experimental consiste en un péndulo fisico (es de-
cir, no puntual) compuesto por una barra homogénea de longitud
2L = 0,6 m, y una barra del mismo material pero largo L cruza-
da a la primera (esta altima la denominaremos cruceta). Es decir,
tenemos una especie de T sujeta cerca de su extremo por un eje

fijo en torno al cual es sistema podra girar libremente.

— - —>

2L
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El montaje experimental les permitira definir cuatro configuraciones distintas, sélo deberan cam-
biar la posicién de la cruceta para realizar las distintas mediciones. Noten que al variar la posicién de
la cruceta varia tanto la posicién del centro de masa de la T' como su momento de inercia (en este
caso en torno al eje de rotacién del extremo superior).

D. Experiencias

Experiencia 1.- Preliminares.

El objetivo de esta experiencia es estudiar el teorema de conservacién de energia. Verifique el
funcionamiento correcto de la cdmara web de acuerdo a las instrucciones en el archivo Uso-
CamaraWeb.pdf. En el computador podra encontrar varios programas para la adquisicién de
videos entre ellos Amcap, GeniusVideo, Tracker y Logitech. Para mejorar la calidad del video,
puede ajustar los parametros de exposicion y brillo.

La idea es soltar la barra desde el reposo en una posicién inicial fija y medir la velocidad angular
(instantanea) y el cambio de altura del centro de masa un intervalo de tiempo después. Luego
podran contrastar el valor de la energia cinética de rotacién experimental obtenida a partir de
la medida de velocidad angular, con la energia cinética de rotacién tedrica calculada a partir del
teorema de conservacion de la energia mecanica.

Verifique el namero de cuadros por segundo que graba la camara. ; Cuan confiable es este valor?
Grabe un cronémetro digital durante 10 segundos y compare.

Busque una posicién inicial donde la medida de la velocidad angular al pasar por la vertical se
logre con la mayor precisién posible.

Indique la posicién inicial escogida, incluya un diagrama. Explique por qué escogié esta confi-
guracion.

Experiencia 2.- Velocidad angular de la barra. Sea = la distancia desde el eje de rotacién a la
cruceta. Para cada configuracion de la cruceta (x) mida 5 veces la velocidad angular de la barra
al pasar por primera vez por la vertical (es decir debe filmar 5 videos desde el angulo inicial
hasta que pasa por primera vez la vertical). Llene la siguiente tabla:

Universidad de Chile oft fcfm
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x Wmedido <wmed> Ow
m rad/s rad/s rad/s rad/s rad/s rad/s rad/s

Calcule la posicion del centro de masa medida desde el eje de rotacién y el momento de inercia
con respecto al mismo eje para cada configuracién de la T. Llenar la siguiente tabla, liste las
unidades de cada columna bajo el encabezado entre los paréntesis.

x TOoM [O

C ) )¢ )

Escriba la ecuacién que utilizara para determinar la velocidad de rotacién de la cruceta al pasar

por la posicién vertical, weqe:

En la tabla a continuacién repita los valores obtenidos para la velocidad angular medida en
funcion de = ({(wimed)) y complete las columnas nuevas con wq. y €l error absoluto y porcentual
de wWyneq €n relaciéon a weq .. Note que es este caso la expresion error no se refiere a la desviacién
estandar, sino a la diferencia entre la prediccién y el resultado experimental. Recuerde que todas
las cantidades tienen unidades. Especifique la unidad correspondiente en cada columna.

T (Wimed) o Weale error-absoluto  error-porcentual

(. e )y ¢y ) oy )
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Grafique en Matlab en un mismo gréfico la velocidad angular calculada weq. en funcién de x
como una linea continua (comando plot) y la velocidad angular medida (wy,eq) con su error
aleatorio o, como simbolos con barras de error vertical (comando errorbar) en funcién de x.

Ejemplo de grafico:
errorbar (x_exp,omega_exp,err_omega,’+’)

hold on
plot(x_calc,omega_calc)

Imprima y adjunte el grafico.

E. Conclusiones

Presente de manera concisa las conclusiones objetivas de la sesién en general, no debe resumir
otra vez todos los resultados, solo aquellos mas importantes.
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Anexo 1: Recetario tutil ImageJ

= ;Como rotar imagenes con ImageJ? Seleccionar Image » Transform » Rotate.

= ;Cémo seleccionar un sector rectangular? Demarcar regién con Rectangular Selection; apli-
car Image » Crop.

= ;COmo medir el angulo de una linea? Seleccionar Angle tool; presionar dos veces el botén
izquierdo del mouse para trazar una linea de referencia y una tercera vez para trazar una segunda
linea. Leer el angulo en la parte inferior del panel ImageJ o bien presionar Control + m para
realizar una medicién.

= jComo medir la longitud de una linea en pixeles? Seleccionar Straight line selection;
presionando el botén izquierdo del mouse, trazar linea y leer su longitud en la parte inferior del
panel ImageJ o bien presionar Control + m para realizar una medicién.

= jCOomo calibrar una longitud en pixeles? Trazar una linea cuya longitud real sea conocida.
Seleccionar Analyze » Set Scale; definir parametros; aplicar opcién Global.

= jCOmo abrir un video en formato avi? Seleccionar File » Import » Using QuickTime ...;
cargar archivo.

= ;Cémo cambiar de color las lineas? Seleccionar Edit » Options » Colors ...; escoger para-
metros.

= ;Como cambiar de grosor las lineas? Seleccionar Edit » Options » Line Width ...; escoger
grosor.

= ;COmo cambiar las tonalidades de una imagen? Seleccione Image » Adjust » Bright-
ness/Contrast y escoja la opcién que le parezca.
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A. Objetivos

Reconocer los efectos de la ecuacién de torque para sélidos rigidos.

Identificar los efectos del momento de inercia en la dindmica rotacional de los sélidos rigidos.

Medir indirectamente el momento de inercia de un sélido mediante la aplicacién de la ecuacién
de torque.

Utilizar las herramientas de anélisis de imagenes para medir angulos.

Usar los ajustes de curvas como herramienta de analisis de datos.

B. Materiales

Polea masiva y pesos de distinta masa.

Camara web.

Regla.

Balanza digital.
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C. Montaje
Para esta experiencia cada grupo contard con
una polea masiva que puede girar con poco roce
en torno a un eje ubicado en su centro. Tendran 0)
ademas a su disposicién un conjunto de golillas '/ " M1
que podran combinar para formar masas my y meo, o) R,
las cuales van colgadas de hilos. La polea tiene
canales a dos radios diferentes donde es posible
enrollar los hilos, tal como se indica en la figura.
Los radios externo e interno son Ry = 5 cmy
Ry = 2,5 cm. Los hilos pueden estar enrollados m‘.
en el mismo sentido (figura de la izquierda) o en
sentidos opuestos (figura de la derecha). ma

D. Experiencias

Experiencia 1.- Preliminares.

Verifique que la polea tenga poco roce con el eje. Para ello, hagala girar y deje que se frene
libremente; repita la experiencia en ambos sentidos. Mida el tiempo que tarda en frenarse y
compruebe que es del orden de 10 segundos.

Tiempo de frenado

Giro en sentido positivo
Giro en sentido negativo

Experiencia 2.- Sentido de giro de la polea.

Mida el sentido de giro de la polea para una combinacién de masas enrolladas en el mismo
sentido y para tres combinaciones enrolladas en sentido opuesto. Compare con la prediccién
tedrica. Llame M; la masa que cuelga del radio Ry y M5 la masa que cuelga del radio Rs.
Llene la siguiente tabla con los resultados:

Forma de enrollar | M; | My | Cuerpo que baja (predicho) | Cuerpo que baja (observado)

Mismo sentido

Sentido opuesto
Sentido opuesto
Sentido opuesto
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Experiencia 3.- Medicién del momento de inercia

Coloque una combinacién de masas diferentes ( )| ( )
entre si que haga que la polea no acelere muy
rapidamente. Comience a filmar, suelte la polea y
filme hasta el final. Analice el video con ImageJ
y obtenga 10 valores de angulos para tiempos
diferentes.

Complete la tabla de la derecha con los valores
medidos.

Grafique los valores medidos con Matlab (no lo
imprima aun, espere agregar el ajuste).

A partir de la configuracién experimental escogida por su grupo, realice los DCL de la polea
y las masas y determine la ecuaciéon de movimiento de la polea. Demuestre que esta ecuacién
corresponde a un movimiento con aceleracién angular constante. Indique todos los datos nu-
méricos (masas, radios, etc) y férmulas que usard para la evaluacién de las cantidades fisicas
importantes.
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Usando la funcién polyfit, ajuste los valores a una parabola. Entregue el grafico con los valores
medidos y ajustados.

Indique el valor ajustado de la aceleracion angular « y el valor deducido (experimental) del
momento de inercia I;"? a partir de . Calcule el valor tedrico del momento de inercia I a
partir de los radios de la polea y su masa.

Valor ajustado de o | Momento de inercia 7 | Momento de inercia I

( ) ( ) ( )

E. Conclusiones.

Presente de manera concisa las conclusiones objetivas de la sesién en general, no debe resumir
otra vez todos los resultados.
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Anexo 1: Mediciéon de angulos con ImageJ

Para medir los angulos el procedimiento mas cémodo es:

= Se filma la polea con la camara web, iniciando la filmacién desde antes de soltar.

= Se abre ImageJ y en el menu “Import” se lee la pelicula como Avi o como secuencia de imagenes,
dependiendo de cémo fue almacenado el video. Hecho esto, es posible analizar la pelicula cuadro
a cuadro.

= Se avanza la pelicula hasta el momento en que ya se ha soltado la polea y se va midiendo el
angulo de la linea blanca cada cierto nimero de cuadros. Se anotan los angulos y tiempos;
para obtener el tiempo, en la parte superior izquierda de cada foto sale el namero de cuadro,
que se convierte a tiempo recordando que cada cuadro se toma aproximadamente cada 1/30 s.
En todo caso se recomienda determinar con mejor precisién el namero de cuadros por segundo
mediante el mismo procedimiento que utilizé en la Unidad 4B (filmar un cronémetro).

= Con esto se obtiene una serie de angulos para diferentes tiempos {t;, ¢;}¥,. Para que la
medicién sea representativa se deben obtener al menos unos diez valores.

Anexo 2: Movimiento uniformemente acelerado

El movimiento de la polea en estas condiciones ocurre con aceleracién angular constante «. Luego,
el angulo evoluciona en el tiempo como un movimiento uniformemente acelerado

6 = fotwolt — o) + galt — 1)’ (4c.1)
= A+Bt+ %atQ = A+ Bt+Ct? (4C.2)

donde se han absorbido los diferentes términos que tienen ¢, en las constantes Ay By se ha definido
C = «/2. En la experiencia w, = 0, pero ¢, y t, seran tipicamente diferentes de cero, de manera
que en ecuacién (4C.2)) los coeficientes A y B seran diferentes de cero.

Para obtener el valor de « de los valores t; y ¢; medidos se usa Matlab:

= Se construyen los vectores t = [t1 to ...] y phi = [phij phis ...].
= Se grafica plot (t,phi, ’*’) para verificar que los datos parecen una parabola.

= Se pide a Matlab que encuentre la mejor parabola (el mejor polinomio cuadratico) que pase lo
mas cercano por los puntos. Este procedimiento se llama ajuste o fit y se hace en Matlab con
la funcién polyfit que entrega los coeficientes del polinomio. En la ventana de comando, esta
funcién se invoca de la siguiente manera:

>> coef = polyfit(t,phi,2)
coef =
XX YY 77

Universidad de Chile oft fcfm



Torque y momento angular Sistemas Newtonianos 31

donde XX es el coeficiente de t? (es decir a/2), YY el coeficiente de t y ZZ el coeficiente
constante. Nétese que el comando polyfit se llama dando como datos, en este orden: (i) el
arreglo de tiempos (variable independiente), (ii) el arreglo de angulos (variable dependiente), y
(iii) el grado del polinomio a ajustar, en este caso 2.

Un ejemplo de cédigo de Matlab para analizar los datos es el siguiente

t = [t1 t2 t3 ...] % Aqui se ingresan los arreglos

phi = [phil phi2 phi3 ...]

plot(t,phi,’*’)

hold on % Se mantiene para poder sobreponer la curva ajustada
coef = polyfit(t,phi,2)

%Se calcula la curva ajustada con los coeficientes pero con un
%vector de tiempo t2 de modo que la curva sea mas suave

ti = 0;

tf = 10; %a definir por ustedes

dt = 0.1; %a definir por ustedes

t2 ti:dt:tf;

phiaju = coef(1)*t2.72 + coef (2)*t2+coef (3)

plot(t2,phiaju)

alfa=2*coef(1) % El valor buscado de alfa
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A. Objetivos

= Conocer el efecto de la distribucién de masas sobre el momento de inercia de un cuerpo.

= Verificar el principio de conservacién de la energia mecanica en situaciones de sélidos que rotan
y se trasladan.

= Distinguir entre energia cinética de rotacién y energia cinética de traslacion.
B. Materiales

= Camara web.
= Cilindros de PVC, plastilina, plano inclinado.

» Regla, transportador, balanza digital.

C. Montaje

Para esta experiencia cada grupo contara con un
plano inclinado similar al que muestra la figura de
la derecha y una cdmara web apoyada en la su-
perficie de la mesa. En el plano inclinado se deben
hacer rodar unos cilindros de PVC preparados se-
gan se indica en el anexo N°1. Para la primera
experiencia debe usar un cilindro solo, por lo tanto
preparelos segin lo indicado en el anexo 1.
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D. Experiencias

Experiencia 1.- Preliminares

Registre los siguientes datos con su error asociado

Distancia camara-pista

Altura de la camara c/r superficie de la mesa
angulo de la pista c¢/r horizontal

Longitud efectiva de la pista(*)

Equivalencia 0.1 m en pixeles

(*) Longitud real que se desplaza el centro del anillo sobre el plano.

Calcule tedricamente el tiempo que tardara el cilindro (sin masa adicional) en recorrer la pista.
Escriban el desarrollo de este calculo en el cuadro a continuacién.

Con ese resultado puede estimar el namero de cuadros que registrara en la pelicula. Grabe uno
o dos videos de la rodadura posando uno de los anillos sobre el plano inclinado en su extremos
superior. Comience a grabar una pelicula y suelte el anillo para que ruede cuesta abajo. Detenga
la grabacion una vez que el cilindro llegue al extremo inferior del plano. Cuide que el cilindro
baje derecho sobre el plano. Compare con su prediccion.

Tiempo estimado de descenso Tiempo medido de descenso
Ecuacién Valor numérico (cuadros) (s)

Comente en tres lineas las precauciones que debera tener en las filmaciones definitivas.
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Experiencia 2.- Mediciones y analisis

Complete las tres tablas siguientes, grabando 4 videos en cada caso. Adjunte un grafico con las
trayectorias y los ajustes como se explica en el anexo 2. Este grafico debe ser presentado solo
para uno de los cilindros utilizados.

CILINDRO A: Masa distribuida en la periferia.

CILINDRO C: Masa concentrada en el gje.

Toma Ajuste polyfit Aceleracion
bo (m) | b1 (m/s) | bg (m/s?) | a, (m/s?)
1
2
3
4
Promedio
Error (o)
CILINDRO B: Masa distribuida uniformemente.
Toma Ajuste polyfit Aceleracién
bo (m) by (m/s) [ by (m/s?) | a, (m/s?)
1
2
3
4
Promedio
Error (o)
Toma Ajuste polyfit Aceleracion
bo (m) b1 (m/s) | ba (m/s?) | a, (m/s?)
1
2
3
4
Promedio
Error (o)
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Experiencia 3.- Predicciones y verificacién.
En base a las aceleraciones obtenidas en la parte anterior, infiera los valores I.,,/M R? para
cada uno de los cilindros, donde I, es el momento de inercia de los cilindros con respecto a
su centro de masa. Escriba el desarrollo de la expresion tedrica que utilizara:

Cilindro az [m/s?] T /M R?
A
B
C

Realice 6 carreras de cilindros y examine el orden de llegada al extremo inferior de la pista. Suél-
telos desde el reposo en la parte superior del plano inclinado y grabe su descenso. En este caso,
ponga su camara mas arriba del plano para tener mejor perspectiva. Examinando los altimos
cuadros de la pelicula determine en que orden llegan los cilindros a la base del plano.

Cilindro | Carrera 1 | Carrera 2 | Carrera 3 | Carrera 4 | Carrera 5 | Carrera 6 | Promedio

A
B
C

Relacione los resultados de esta tabla con las acelaraciones a, medidas en la parte anterior.
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E. Conclusiones

Presente de manera concisa las conclusiones objetivas de la sesién en general.
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Anexo 1: Preparacién de la experiencia

Tome cada uno de los tres cilindros de PVC vy distribuya la plasticina en su interior en forma
simétrica respecto al eje que pasa por el centro del cilindro. Se trata de generar geometrias simples
para las cuales sea posible estimar su momento de inercia. En un caso distribuya la plasticina sobre
el borde externo del cilindro, en otro distribuya la plasticina formando un disco y finalmente intente
concentrar la plasticina en el centro del tercer cilindro.

Cuide que la distribucién de masa garantice que se cumplan de mejor forma los supuestos de la
descripcion tedrica de una rueda rodando; en particular, que el centro de masas coincida con el eje del
cilindro. Ademas, que la distribucién de masa sea simétrica con respecto al eje de simetria del cilindro.
De no ser asi, lo mas probable es que el cilindro tienda a desestabilizarse a medida que incrementa su
velocidad.

Apoye la camara web en la superficie de la mesa y disponga el plano inclinado (en adelante, la
pista) frente a la cdmara, a unos 0.5 — 1.0 m de ella. El eje de la camara debe ser perpendicular al
plano sobre el cual ocurre el movimiento sobre la pista. Busque una configuracién tal que se vea la
mayor parte de la pista en el video. Si no es posible ver la pista completa, apunte la camara tal que
se grabe la parte central de la pista

Mida la inclinacién de la pista con respecto a la horizontal. Ello se infiere de su angulo con la
vertical, definida por la direccion de una plomada que Ud. puede construir o implementar; o bien
se puede medir con transportador o utilizando ImagelJ. La inclinacién ideal del plano probablemente
estara en el rango 4°-10°.

Para elegir la inclinacién a usar, es importante probar que los cilindros aceleren suficientemente
rapido para que sea medible, y que aceleren suficientemente lento de modo de alcanzar a medir al
menos 6 pares (tiempo,posicion) en el video grabado (y para que los cilindros aparezcan nitidos en el
video).

iAseglrese de mantener esta configuracién (cilindros, plano, camara) inalterada durante toda la
experiencial
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Anexo 2: Analisis
Abra ImageJ e importe cada una de sus peliculas.

ImageJ tiene una herramienta para medir distancias. La medicion esta en pixeles, asi que establezca
la relacion entre pixeles y metros midiendo con ImageJ la banda negra en el borde del plano inclinado
(que mide 0.1 m).

Luego mida y tabule la posicién del centro del cilindro aproximadamente cada 5 o 10 cuadros
con respecto a un punto arbitrario pero fijo durante sus mediciones. El numero exacto de cuadros a
saltarse para analizar las imagenes dependera del tiempo total, por lo tanto del namero de cuadros en
total que se dispone. Se debe tratar de medir por un tiempo tal que la carrera del cilindro abarque la
maxima distancia posible en la pista. De esta manera, se podra poner en evidencia el comportamiento
cuadratico de la distancia en funcién del tiempo. Por ejemplo, si un video tiene 60 cuadros, entonces
analice cada 10 cuadros de manera de tener 6 pares de datos tiempo y posicién. En cada video mida
un minimo de 6 pares (cuadro, posicién).

Para cada pelicula Ud. tiene una serie de pares (¢, z) donde ¢ se mide en namero de cuadros y
es la distancia a lo largo del plano desde el extremo superior medida en pixeles. Ingrese esos datos a
un archivo de Matlab, convierta el tiempo de cuadros a segundos, y la posicién de pixeles a metros.
La camara web graba cuadros cada aproximadamente 1/30 segundos. Grafique (¢, x) y verifique que
obtiene aproximadamente una parabola. Ajuste un polinomio de segundo orden (polyfit(t,x,2)),
tal que x(t) = bot? + byt + bg. Si tiene dudas sobre el comando polyfit, escriba help polyfit en
Matlab.

Para uno de los cilindros, grafique los cuatro ajustes obtenidos con polyfit junto con los datos
medidos. Para ello se recomienda dividir la ventana en cuatro para mejor claridad, por ejemplo:

subplot(2,2,1), plot(tl,x1,6’), hold on, plot(tl_fit,x1_fit)
subplot(2,2,2), plot(t2,x2,6’), hold on, plot(t2_fit,x2_fit)
subplot(2,2,3), plot(t3,x3,6’), hold on, plot(t3_fit,x3_fit)
subplot(2,2,4), plot(t4,x4,6’), hold on, plot(t4_fit,x4_fit)

Rotule los graficos con ejes, unidades, fecha y grupo. Adjunte el grafico a su informe.

Relacione el coeficiente by con la aceleracién del cilindro (a,) suponiendo un movimiento unifor-
memente acelerado. De esta forma, para cada cilindro, obtendra 4 valores experimentales de a,.

A partir de los valores obtenidos experimentalmente para a,, infiera el valor experimental de
I /M R? en los tres casos de distribucién de masa estudiados. En las situaciones idealizadas ilustradas
en la figura los cocientes I, /M R? son 1, 1/2, & < 1 respectivamente.

7 N
/ \
1 \
. @
\ /
N /7
Periferia Uniforme Centrada
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A. Objetivos

= Caracterizar el movimiento periédico de un péndulo fisico, en particular la dependencia del
periodo con la amplitud y con el largo.

= |dentificar errores aleatorios y sistematicos en las mediciones.

B. Materiales

Soporte universal.

Regla de 0.6 m de longitud con rodamiento cerca de un extremo.

Regla de 0.3 m de longitud (cruceta para formar la T).

Camara web y programa de visualizacion.

Regla y/o transportador.

C. Montaje
< 2L >

El montaje experimental es idéntico al usado en la unidad 4B. _
Consiste en una barra de longitud 2L y otra de longitud L
(“cruceta”) cruzada sobre la primera, formando una “T". La |

posicién de la cruceta puede variarse facilmente. Notar que l

al variar la posicién de la cruceta, varian tanto la posicién del
centro de masa de la T como su momento de inercia (en este
caso en torno al eje de rotacién del extremo superior). < X >
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D. Experiencias

Experiencia 1.- Preliminares

Montar la cruceta y verificar el funcionamiento correcto de la camara web, de acuerdo al
anexo 1. Indique el angulo inicial escogido (angulo con respecto a la vertical) y estime su
error.

angulo inicial Error Absoluto Error Porcentual

Mida el namero de cuadros por segundo que graba la camara filmando por 10 segundos un
cronémetro.

A continuacién mida el periodo de oscilacién de la cruceta, anote el niamero de medidas del
periodo realizadas y su estadistica:

N (T) or or/(T)

Observaciones: Indique el namero de videos tomados y la forma como se midi6 el periodo:

Experiencia 2.- Periodo en funcién del angulo inicial 6,4,

El angulo inicial 6,45, también llamado amplitud, es la constante de la expresiéon 6(t) =
Omaz cos(wt+¢,). A continuacién estudiara la dependencia del periodo de oscilacién en funcién
de la amplitud de oscilacién.

Indique la posicion de la cruceta que utilizarad en sus mediciones. Si es diferente de la utilizada
en la experiencia anterior justifique la razén del cambio.

Complete la siguiente tabla con un minimo de 5 amplitudes (6,,4.) distintas. Si le es atil, copie
los resultados de la tabla de preliminares en una linea de la tabla mas abajo. ¢, es la constante
de fase.
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Amplitud ©o N (T) or or/{T)

Grafique con Matlab en una misma figura el periodo medido en funcién de la amplitud con su
error absoluto y el periodo esperado para las pequefias oscilaciones de un péndulo fisico como
la cruceta que usted usé. Imprima y adjunte el grafico al informe.

Nota: Para el grafico se debe conocer la posicién del centro de masa y el momento de inercia
del péndulo con respecto al eje de rotacién I, (realmente no es necesario conocer el momento
de inercia, sino el cociente I,/M). Ya se conoce la posicién del centro de masa y el momento
de inercia de la T, en caso de haberlo olvidado, se usa el teorema de los ejes paralelos (teorema
de Steiner).

Experiencia 3.- Periodo en funcién de la longitud.

A continuacién estudiara la dependencia del periodo de oscilacién en funcién de la posicién de
la cruceta (z).

Indique que amplitud utilizara en sus mediciones. Si es diferente de la utilizada en las experien-
cias anteriores justifique la razén del cambio.

Calcule la posicién del centro de masa medida desde el eje de rotacién (xcpr) y el momento de
inercia con respecto al mismo eje para cada configuracién de la cruceta (I,). Llene la siguiente
tabla incluyendo unidades.

T TOM I,/M

Mida el periodo de la cruceta para cada configuracién. Si le es til, copie los resultados de
la parte preliminares en una linea de la tabla. Calcule también el valor del periodo esperado
(Teaic) suponiendo que la cruceta se comporta como un péndulo fisico oscilando con amplitud
pequena.
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x N (T)

arT

Tcalc.

(T) — Teate.) /o1

Grafique con Matlab en una misma figura el periodo medido en funcién de la longitud efectiva
xoam con su error absoluto y el periodo calculado para las pequefias oscilaciones de la cruceta.

Imprima y adjunte el grafico al informe.

E. Conclusiones

Presente de manera concisa las conclusiones objetivas de la sesién en general.
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Anexo 1

Al inicio de cada experimento es necesario verificar el funcionamiento correcto de los elementos
a usar. Hoy se deberd medir repetidas veces el periodo de un péndulo. El objetivo de la seccién
preliminares es probar el equipo y estimar el error con el cual se puede medir dicho periodo.

Se recomienda comenzar con la T en su configuracién mas extendida (distancia del centro de
masa al eje de rotacién.)

Para medir el periodo del péndulo se debe grabar videos con al menos una oscilacién completa del
péndulo. Para minimizar el efecto del roce se debe medir el periodo de la primera oscilacién en cada
video, antes de que la amplitud de oscilacién decaiga por efecto del roce. Para cada configuracion
experimental se debe grabar varios videos, tantos como sea necesario para llegar a un error menor al
10% en la determinacién del periodo.

Estas mediciones seran muy rapidas, ya que simplemente se debera examinar visualmente los videos
cuadro a cuadro para encontrar el nimero de cuadros que corresponde al periodo. Recordar que el
periodo corresponde al intervalo de tiempo entre dos fases idénticas del movimiento (por ejemplo, dos
maximos sucesivos, dos minimos sucesivos o la distancia temporal entre tres pasadas por la vertical).
La camara graba a aproximadamente 30 cuadros por segundo.
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A. Objetivos

= Determinar la frecuencia natural de oscilacién del sistema.
= Reconocer que este sistema se describe por la ecuacién de un oscilador amortiguado forzado.

= Realizar una serie de medidas de la amplitud de movimiento de un carro y de la frecuencia de
forzaje, obteniendo asi una curva de resonancia del sistema mecanico bajo estudio.

B. Materiales

= Un riel, un carro, dos resortes, un motor y una barra en forma de “L".

Lentes de proteccién.

Fuente de poder y cables.

Cronémetro y una regla.

Matlab.
C. Datos

= Masa del carro = 500 g
= Masa del motor mas pernos mas acrilico = 213 g

= Masa de la barra en forma de “L" =40 g
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D. Montaje

El montaje experimental consiste de un carro que se desplaza de forma horizontal sobre un riel en
una sola dimensién. El carro se encuentra unido a los extremos del riel mediante dos resortes estirados
y sobre la superficie del carro se encuentra un motor que posee una barra en forma de “L". La barra
rotara en torno al eje del motor, a una frecuencia que depende del voltaje aplicado a la fuente de
poder. Por seguridad no utilice un voltaje de operacién superior a 10 V. La barra actiia como elemento
de forzamiento para el carro. Para mas detalles vea el anexo 1.

>
0 x(t)

E. Experiencias

Experiencia 1.- Medicién de la frecuencia natural de vibracién ws,.

Determine la frecuencia natural de oscilacién w, como se indica en el anexo 2. Esta experiencia
debera ser realizada al comienzo de la sesién practica y una sola vez por mesa de trabajo, es
decir los tres grupos al mismo tiempo.

Llene la siguiente tabla con las medidas de su grupo y las de los otros dos grupos de su mesa:

Tmedido N, oscilaciones Wo

Llene la siguiente tabla con el valor medio y error absoluto de la frecuencia de oscilacién, la
masa correspondiente (con una estimacién de su error) y la constante total k del sistema. No
desmonte el carro para medir su masa, si no que use el valor indicado en la seccion C. Datos.
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Resumen Experiencia 1
(wo) £ Aw,
M
(k) £ Ak

Experiencia 2.- Medicién de la constante de amortiguamiento.

En esta experiencia determine el tiempo caracteristico de amortiguamiento 7, segin se explica
en el anexo 3. Llene la siguiente tabla con los tiempos ¢, la amplitud de cada oscilacién A(t),
y el logaritmo natural de A(t)/Ag, donde Ag es la amplitud inicial.

t A [ In(A(t)/A)
( ) | ( )| ( )

Adjunte un grafico del logaritmo de la amplitud de las oscilaciones en funcién del tiempo e
indique el tiempo caracteristico de amortiguamiento.

Experiencia 3.- Medicién de la curva de resonancia.

Obtenga una serie de medidas experimentales de la amplitud de oscilacién (parte estacionaria,
B) en funcién de la frecuencia angular w impuesta al sistema, tal como se indica en el anexo 4.

Estime el error absoluto de sus medidas de frecuencia de oscilacién w usando el cronémetro y
el error absoluto de amplitud de oscilacién B usando la regla:
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Llene la siguiente tabla:

Vo Tmedido N, oscilaciones w B

Experiencia 4.- Resumen final.
Para concluir, les pedimos dibujar en un mismo grafico bien rotulado, que deben adjuntar al
informe:
= Experiencia 3: Graficar las 10 medidas de la amplitud B en funcién de w, con su error
estimado utilizando errorbar sin unir los puntos con lineas;

= Curva teérica: La curva de amplitud en funcién de w considerando los valores medidos
de la frecuencia natural w, y del tiempo caracteristico de amortiguamiento 7 (ver el
anexo 5).

F. Conclusiones

Presente de manera concisa las conclusiones objetivas de la sesién en general.
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Anexo 1

En esta sesién se utilizard una fuente de poder para alimentar de corriente a un motor, el cual
opera a un voltaje maximo de 12 V. Se debera manejar con cuidado la fuente, por seguridad no
utilice un voltaje superior a 10 V. Fije el voltaje en 0 antes de encender la fuente de poder para evitar
movimientos bruscos del motor.

La barra en forma de "“L"” rotara en torno al eje del motor, a una frecuencia maxima de rotacién
de aproximadamente 2 vueltas por segundo (2 Hz). Esta barra es la que actia como elemento de
forzamiento para el carro, de manera analoga al modelo simple expuesto en la guia tedrica. Esta barra
se encuentra firmemente acoplada al eje de rotacién del motor. Se exige el uso de lentes de proteccién
durante el uso del equipo experimental.

A diferencia de otras sesiones practicas, existe un solo modelo de este experimento por mesa de
trabajo, por lo que se debe adoptar un sistema de turnos. La experiencia 1 se realizarad una sola vez
por mesa, los tres grupos al mismo tiempo. Es una experiencia corta pero necesaria para el buen
desarrollo del resto de la sesion. Las experiencias 2 y 3 se pueden realizar en cualquier orden entre
ellas, pero después de la experiencia 1. Es aqui donde deberan implementar un sistema de turnos por
grupo. La experiencia 4 debe realizarse al final, cada grupo por su cuenta.

Anexo 2

Esta experiencia debera ser realizada al comienzo de la sesién practica y una sola vez por mesa
de trabajo, es decir los tres grupos al mismo tiempo.

Para ello imponga una condicién inicial al carro y mida la frecuencia de oscilacién (en unidades
de rad/s). Se recomienda una velocidad inicial nula pero una posicién inicial entre 5 y 10 cm con
respecto a su posicién de equilibrio. En realidad, tratandose de un oscilador amortiguado, lo que se
mide es la frecuencia 2 = /w2 — (1/27)2, siendo w, la frecuencia natural de oscilacién y 7 el tiempo
caracteristico de amortiguamiento. Por ahora supondremos que la disipacién es pequefia por lo que

~ w,. Esta suposicion sera validada después.

Para medir la frecuencia de oscilacién utilice un cronémetro para medir el tiempo que toma el
carro en realizar 10 oscilaciones. Cada grupo debera realizar 4 medidas, lo que dara un conjunto de
12 medidas por mesa, las cuales compartiran. Reporte el valor medio y la desviacién estandar de w,.
Ademas, determine el valor medio de la constante elastica total k, suponiendo que los resortes son
iguales de constante k/2 (para resortes en paralelo se suman las constantes elasticas).

Anexo 3

En esta experiencia determinaran el tiempo de amortiguamiento del oscilador debido al roce. Para
ello deben hacer oscilar al carro y dejarlo oscilar hasta que se detenga por efecto del roce. Deben
grabar el movimiento del carro, sin embargo no es necesario grabar toda la amplitud del movimiento,
basta con registrar la posicion maxima que alcanza el carro en uno de los extremos de su trayectoria
(es decir, la amplitud de oscilacién). Se les recomienda organizarse por cada mesén para grabar tres
videos, uno para cada grupo, después de haber realizado la experiencia 1.
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Se espera que la amplitud de oscilacién decaiga exponencialmente segin la ley
A(t) = Age H(7),

donde Ag es la amplitud inicial y 7 el tiempo de amortiguamiento que se desea medir. Al graficar
In (A(t)/Ap) en funcién del tiempo, se deberia obtener una recta con pendiente negativa. La pen-
diente corresponde a —1/(27).

Anexo 4

En esta parte deberan obtener una serie de medidas experimentales de la amplitud de oscilacién
(parte estacionaria, B) en funcién de la frecuencia angular w impuesta al sistema.

En primer lugar se recomienda encontrar, en forma aproximada, el voltaje de la fuente de poder
para el cual el sistema es resonante, es decir para el cual el carro se mueve con una maxima amplitud.
Para ello se recomienda partir con el carro en reposo en su posicién de equilibrio. Aumente lentamente
el voltaje hasta determinar el voltaje V,, donde la amplitud de oscilacién es maxima.

Realice entonces una serie de medidas para al menos 10 valores de w en torno a w,; dicho de
otra manera debera medir la respuesta del sistema para al menos 10 valores de voltaje en torno a V,

(£20 %). Recuerde que la respuesta maxima del sistema estd dada por w, = /w2 — 2(1/27)2. En
conclusién, Q, w, y w, son diferentes, pero para disipacién pequefia, Q ~ w, ~ w,.

Se debe medir w para cada voltaje con el cronémetro y la amplitud de oscilacion con la regla que
se encuentra pegada al riel. Recuerde esperar que se amortigiie el estado transiente del sistema pues
se quiere obtener la amplitud de oscilacién en el estado estacionario. Estime el error absoluto de su
medida de amplitud usando la regla.

Anexo 5

La solucién estacionaria para un oscilador arménico forzado y amortiguado que satisface la ecuacién
de movimiento

P+l wir = f,sen(wt),
T

es
Jo
Test(T) = sen(wt — 6),
=T e Y
con w
tan5 = W
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A. Objetivos

m Describir las caracteristicas de la solucién de D' Alambert.

m Reconocer que con adecuadas combinaciones de sumas de soluciones de D' Alembert se pueden
reproducir las distintas condiciones iniciales.

= Determinar la relacién entre los pardmetros fisicos de un medio en el cual se propaga una onda
a partir de las oscilaciones del medio.

B. Materiales

= Matlab:
Iteraciones
Evaluacién de funciones

Grafico de funciones
= Un sistema de varillas para producir ondas de torsién (demostrativo)

= Uso de ImageJ para medir distancias
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C. Experiencias

Experiencia 1.- Interpretacién de la solucién de D' Alambert.

Usando Matlab escriba un programa que grafique la solucién de D’ Alambert
u(z,t) = f(x —ct) + g(x + ct)

para las funciones f y g, en los intervalos de distancia = y tiempo ¢ indicados en el anexo 1.
Adjunte el archivo .m y los tres graficos al informe.

Indique qué observa

Caso 1:

Caso 2:

Caso 3:

Indique entonces como se interpreta la solucion de D' Alambert a la ecuacién de ondas.

Experiencia 2.- Velocidad vertical de la cuerda.

Considere las funciones f(z) = g(x) indicadas en el anexo 2, y escriba un programa Matlab
que grafique el desplazamiento u y la velocidad v usando los valores de x, t, y ¢ indicados.
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Indique qué se observa en el grafico del desplazamiento u y la velocidad v.

Experiencia 3: Momentos de inercia del sistema de varillas.

Considere el sistema de varillas expuesto en clase, anexo 3. En u-cursos ustedes disponen
de un video en el cual hay un pulso que se envia desde un extremo del sistema (con varillas
de momento de inercia I;) hasta el otro extremo (con varillas de momento de inercia Is).
Determine la velocidad de propagacién del pulso en ambos medios para determinar el cuociente
entre los momentos de inercia, I1/I5.

Escriba la expresién que permite obtener I /15 a partir de las velocidades medidas, ¢1 y co.

Llene con los datos medidos

Velocidad medio 1
Velocidad medio 2

Nota: como después tendrd que dividir las velocidades, puede usar las unidades que desee
mientras sea consistente (por ejemplo, pixeles/cuadro).

Escriba el valor que resulta

L/, =
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Compare con el valor tedrico que se obtiene de medir los largos de las varillas.

D. Conclusiones.
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Anexo 1: Funciones f y g
Se vio en clases que
u(z,t) = f(x —ct) + g + ct)

es solucién de la ecuacién de ondas para cualquier funcién fy g. En esta primera experiencia se pide
graficar u(x,t) en funcién de 2 a medida que el tiempo avanza para las siguientes funciones f y g.

Caso 1
1 cm
J(@) = (x/5 cm)? +1
g(x) =0
Graficar en el rango —100 cm < z < 100 cm para t = 0,...,40s. Usar ¢ = 1 cm/s y
c=2cm/s.
Caso 2
flz)=0
2 cm
9(x)

- exp(z/10 cm) + exp(—x/5 cm)

Graficar en el rango —100 cm < x < 100 cm parat =0,...,40 s. Usar c =1 cm/s.

Caso 3
1 cm
J(z) = (/5 cm)? + 1
(z) = 2 cm
)= exp(z/10 cm) + exp(—x/5 cm)
Graficar en el rango —100 cm < x < 100 cm parat = —80s,...,80 s. Usarc=1 cm/s.

A modo de ejemplo, un programa Matlab que realiza el primer caso con ¢ = 1 es

c=1;

x=-100:1:100;

for t=0:2:40
y=x-Cc*t;
u=1./((y./5).72+1);
plot(x,u)
pause

end

donde se debe apretar Enter para pasar de un grafico al otro.
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Anexo 2: Calculo de la velocidad vertical de la cuerda.
Si
u(z,t) = f(x —ct) + g(x + ct)
es el desplazamiento vertical de una cuerda tensa, entonces la velocidad vertical de cada pedazo de
cuerda se obtiene como v(x,t) = du(x,t)/dt. Usando la regla de la cadena se obtiene

v(z,t) = —cf'(x — ct) + cg'(x + ct)
donde f’y ¢’ son las derivadas de f y g respecto a su argumento.

Considere el caso en que

1 cm
f(z) =g(z) = m
Se pide graficar u y v en el rango =100 cm < x <100 cmy ¢t =0,...,40 s. Use c = 1 cm/s.
Anexo 3

En la guia tedrica se describi6 las propiedades del sistema de la figura

Vistadesde arriba

Vista en perspectiva

donde se vio que
c=+/TA?/I

con T un torque caracteristico del hilo, A la separacién entre las varillas e I el momento de inercia
de éstas.

En el laboratorio disponemos de un sistema que tiene varillas de dos largos diferentes, con mo-
mentos de inercia diferentes I7 e I5.

Vistadesde arriba
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Nombre

RUT

Firma

Seccién | Grupo

A. Objetivos

= Visualizar ondas viajeras y estacionarias en una cuerda tensa.

= Usar las ecuaciones cinematicas para ondas viajeras y estacionarias.

= Determinar frecuencia y longitud de onda de modos normales de oscilacién de una cuerda finita.

B. Materiales

C. Montaje

Generador de sefiales (frecuencia)

Cuerda fija en dos extremos.

Video con ondas en un arreglo de varillas.

Masas para tensar cuerda y balanza digital.

Se dispondra del montaje experimental mostrado en la
imagen. Un extremo de la cuerda se ata al generador de
pulsos, que oscila con amplitud y frecuencia variables. El
otro extremo de la cuerda pasa por una peque?a polea
a una distancia L desde donde se aplica una tensién
conocida colgando masas calibradas. Dada la tensién
y largo de la cuerda esta tendrd modos normales de
oscilacién bien definidos.

Wave
Generator

Wave Driver
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D. Experiencias

Experiencia 1.- Longitud de onda vs momento de inercia de varillas.

Bajar video6b.avi de u-cursos. Medir la longitud de onda y completar la siguiente tabla de

acuerdo al anexo 1:

N;

varillas largas
Al

gl NC

varillas cortas
Ac Oc¢

Calcular la razén entre los momentos de inercia de las varillas largas y cortas. Indique la expresion
que utilizara para I;/I. y su valor numérico:

Compare el valor de I;/I. con el esperado.

Experiencia 2.- Calculo de tres primeras frecuencias de modos normales f;,..

Ahora debe generar modos normales n = 1,2, 3, ... en una cuerda tensa forzada con frecuencias
entre 1y 100 Hz. Varie lentamente la frecuencia del generador de pulsos hasta obtener el primer,
segundo y tercer modo normal. Para cada modo normal, anote la longitud de onda y la frecuencia

a la cual se forma.

Debe calcular la densidad lineal de cuerda. Note que debe ser cuando estd tensada, pues su
densidad lineal cambia con su elongacion.

largo cuerda tensada

masa cuerda

densidad lineal de masa

Longitud (solo de la parte que oscila) y tensién de cuerda en montaje experimental:

L

masa carga

tension

Universidad de Chile

oft

fcfm




Ondas estacionarias

Sistemas Newtonianos

66

Frecuencias normales tedricas de la cuerda en el montaje experimental (sub-indice ¢ es de

calculado):

flc

f20

f3c

Experiencia 3.- Medicién de las tres primeras frecuencias de modos normales f,, anexo 2 (copie

las frecuencias f,. calculadas).

fn

fne

/L

W N3

E. Conclusiones
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Anexo 1: Razé6n de momentos de inercia

En el video6B.avi publicado en U-Cursos se muestra el mismo arreglo de varillas de distinto largo
utilizado en la experiencia 6A. Estas estan siendo perturbadas en un extremo por un movimiento
periédico de modo de producir ondas armoénicas desplazandose hacia la izquierda. En esta primera
experiencia se pide que midan la longitud de onda en el sector de varillas largas y en el sector de
varillas cortas. A partir de estas medidas determine la razén entre los momentos de inercia de las
varillas largas y las varillas cortas.

1. Medir la longitud de onda (en pixeles) en el sector de varillas largas tantas veces como sea
necesario de modo de obtener un error de medicién relativo menor a un 5%. Para ello puede
medir cuadros distintos del video o bien medir en sectores distintos en cada cuadro, siempre y
cuando sean todas las varillas del mismo largo. Reporte el nimero de mediciones Ny, la longitud
de onda \; (en pixeles) y su desviacién estandar o; (en pixeles).

2. Repita para el sector de varillas cortas N,, A, oe.

3. Calcule el cociente de los momentos de inercia I;/I. a partir de \;/\.. Comente si es consistente
con el valor esperado a partir de la razén de los largos de las varillas largas y varillas cortas.

Anexo 2:

Calcule en forma tedrica la frecuencia a la cual se forman los modos normales que encontré de
manera experimental (para eso necesita conocer la velocidad de fase, dependiente de la tensién y
densidad lineal de masa de la cuerda). Compare los valores medidos (f,,) y calculados (fy.) de las
frecuencias de resonancia y comente sobre su similitud o diferencia.

1. Medir el largo y la masa de la cuerda. Necesitan calcular la densidad lineal de masa de la cuerda
ya tensada, para ello marque los extremos de la cuerda tensa y luego mida su largo natural (no
tensado).

2. Medir el largo de la cuerda entre el generador de pulsos y la polea con su estimacién de error.
Calcular la tensién de la cuerda a partir de la masa colgada. El profesor o los auxiliares indicaran
a cada grupo la masa y largo de la cuerda para su experimento.

3. Calcular las frecuencias de los tres primeros modos normales para el montaje experimental de
la experiencia 2.
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A. Objetivos

Reconocer que los cuerpos sumergidos experimentan una fuerza de empuje vertical, en sentido
opuesto al peso del mismo.

Realizar medidas de fuerza de empuje con objetos sumergidos en agua.

Realizar una calibracién del sensor de fuerza.

Verificar experimentalmente el principio de Arquimedes.
B. Materiales

» Sensor de fuerza, varias masas conocidas

Una esfera de vidrio y un cilindro metalico

Un soporte universal

Una cubeta, agua

Pie de metro y una balanza digital

Matlab y SignalExpress

C. Montaje
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D.

Se dispone de un montaje experimental (imagen de la de-
recha) que permite estudiar el principio de Arquimedes y la
fuerza de empuje que siente un objeto de cierta densidad p,
al estar sumergido bajo un fluido de densidad ps. Se usara
el sensor de fuerza en el extremo del soporte universal y se
realizara la adquisicion de datos con la tarjeta de adquisicién. _ Oi

Experiencias

En esta practica se realizaran medidas de fuerza (peso), longitud y masa. Las medidas de fuerza

se realizaran usando el sensor, la tarjeta NI-USB-DAQ y el programa SignalExpress. En U-Cursos
encontrara un programa llamado Empuje-SignalExpress.seproj que le permitirad tomar 1 s de medidas
a una velocidad de 200 medidas por segundo. Para cada medida de fuerza debera reportar el valor
promedio y el error obtenido con esta serie de medidas.

Experiencia 1.- Calibracién del sensor de fuerza en el rango £10 N.

El buen desarrollo de esta sesién requiere de una calibracién de cada sensor de fuerza. Esto
significa que cada grupo tendra que obtener las constantes de conversién A 'y B de la relacion
lineal ' = A-U + B de su sensor de fuerza. Es importante notar que la masa del gancho
del sensor, que llamaremos m¢, no es conocida. En principio se debe tratar de determinar esta
masa. Para ello siga el procedimiento indicado a continuacion.

1. Mida el voltaje correspondiente al peso del gancho del sensor, primero con el sensor apun-

tando hacia “arriba”, y después, hacia “abajo”. Denotaremos al conjunto voltaje-fuerza
(U_,F_)y (U4, Fy) respectivamente.

. Para al menos 4 masas diferentes, obtenga una medida del valor medio y error absoluto

de cada voltaje asociado. Reporte los datos en una tabla. Agregue a esta tabla los valores
obtenidos en la parte anterior.

. A través de una regresién lineal obtenga los valores de las constantes A y B. Para ello

siga estos pasos: (1) Dado los valores promedios de cada voltaje asociado a cada masa se
obtiene el siguiente conjunto de ecuaciones

F = —mgg=A-U_+B,

Fy = +mgg=A-Us+ B,

Fr = (mi+mg)g=A-Ui+ B,

F, = (m2+mg)g=A-Us+ B,etc...

donde mq, ma, ... son las masas utilizadas. (2) A pesar de que no conocemos m; se puede
realizar una regresién lineal con el conjunto de datos (U1, m1g), (Ua, mag), etc.. pero con
las constantes A y B’ = B — mgg. (3) Determinados A y B’, obtenga B y m¢ con las
dos ecuaciones para F_ y F.
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Nota: La regresion lineal se debe hacer con la funcién polyfit de Matlab. Si tiene dudas
de su utilizacién escriba help polyfit en la linea de comando de Matlab.

Experiencia 2.- Principio de Arquimedes.

En esta parte se estudiara el efecto de sumergir un objeto de masa y volumen conocido bajo el
agua. Se estudiaran dos objetos, una esfera de vidrio y un cilindro metalico. El objetivo principal
es verificar que se cumple el principio de Arquimedes.

Se pide que haga lo siguiente:

1.

Usando la balanza digital, mida por separado la masa de la esfera y del cilindro. Realice
5 medidas y, reporte un valor promedio y su error absoluto. Si la desviacién estandar es
nula, considere la precisiéon del instrumento.

Usando el calibre, mida por separado el volumen de la esfera y del cilindro. Realice 5
medidas y, reporte un valor promedio y su error absoluto. Si la desviacién estandar es nula,
considere la precisién del instrumento.

3. Usando los datos obtenidos, determine la densidad de cada uno de los objetos (p,).

Con el sensor de fuerza mida el peso de cada objeto, que denotaremos P,, sin que estos
estén sumergidos bajo el agua. Compruebe que P, = M,g, donde M, es la masa del
objeto.

. Con los cuerpos completamente sumergidos en agua, repita las mediciones del peso de

cada objeto (P;).

Determine la fuerza de empuje E que experimenta cada objeto a partir de las medidas de
P,+ AP,y P, + AP;. Compare sus mediciones de F con la prediccién del Principio de
Arquimedes, es decir £ = p;Vg.

E. Conclusiones.
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